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Extended G/L Accounts 

Extended G/L Accounts is an enhanced replacement for the Sage G/L Accounts screen that provides a 

mechanism for maintaining a full or partial set of Sage 300 G/L Accounts across multiple companies with 
the same – or different – functional currencies. 

Access is through the Copy Accounts button that has been added to the bottom of the Sage 300 G/L 
Accounts window.  

Accounts and companies can be filtered and “cherry-picked”, and the program includes sophisticated 
error-checking to protect against inconsistent multi-currency operations.  

When finished a copy operation, you can view and print a full log of changed accounts. 

See Important Notes regarding the operations to be performed in this document. 

There are important distinctions between adding an account into multiple companies, 
changing an account description in multiple companies, and attempting to update all 
account properties across multiple companies (when a target account may already be in 

use).  

Extended G/L Accounts lets you: 

• Maintain a full or partial set of G/L accounts across multiple Sage 300 companies with the same 
or different functional currencies using the Copy Accounts functionality. 

o Specify a range of accounts from the current company, filter them by additional criteria, 

cherry-pick accounts from the results, and then copy the final set to other associated Sage 
300 companies. 

o Substitute account segments. 
o Select or de-select companies on an individual basis. 
o Update account descriptions only. 
o Include account multicurrency information. 
o Display a full log of updated accounts. 

The following screens show the additional Copy Accounts button on the Extended G/L Accounts screen: 

Sage G/L Accounts screen TaiRox Extended G/L Accounts screen 
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The Extended G/L Accounts icon appears under TaiRox Productivity Tools > General Ledger 
Tools on the Sage 300 desktop and can be copied to other menu locations. 

 
Enterprise Productivity Tools appear if you have an Enterprise license from TaiRox Software. 

Copy G/L Accounts to other Sage 300 companies 

Extended G/L Accounts operates from within an existing “source” company for copying G/L accounts.  

• Click the Copy Accounts button to pop up a window that allows you to select by range and filter 
accounts in the source company, filter and substitute account segments, then load and 
individually select or de-select accounts before copying. 

• Click the Copy button on the pop-up screen to select from a list of “target” companies to which 
accounts can be copied and to select the operation to be performed (Insert Only, Update Only, 
Insert and Update).  

• Click the OK button to start the copy operation. When copying is complete, you can review the log 
file by clicking the Log button. 

IMPORTANT:   

You must enter a User ID and Password to copy G/L account information. Make sure that 
the User ID has sufficient rights to complete the operation in the target companies.  

If you are inserting new accounts into other companies, check that a current backup exists 
for all databases being affected. 

• Open the Sage 300 company with the G/L accounts that you want to copy. 

Copy Accounts operates from within an existing “source” company, and lets you copy account 
information to other “target” Sage 300 company databases.  

• Open the Extended G/L Accounts form, and click the Copy Accounts button at the bottom of the 
screen. 

 

When you click the Copy Accounts button, a window will pop up for selecting G/L accounts in the 
current (source) company. 
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Note:  By default, the grid at the bottom of the form will display new accounts that were added in this 
session. This allows you to copy only the new account changes directly to other Sage company 
databases. 

You can clear any accounts from the grid by selecting File > Clear List of Accounts Changed This 
Session from the File menu at the top of the form. The grid will also be updated when you click the 
Load button. 

To copy or update any set of accounts, start at the top of the form to specify the range of G/L 

accounts that you want to copy or update. The program displays the last set of ranges and filters 
used for copying and updating accounts. Click the Load button to use the previous settings. 

Specify range of G/L accounts for copying: 

You can specify up to seven ranges of G/L Account fields to use for account selection – including the 
account number, structure code, account group code, or any of the optional fields that you use for G/L 
accounts.  

 

• The selection list in the screen above includes two optional fields – Account Class and Cash Flow 
Type – that you can use for account selection. 
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Choose additional criteria: 

 

• Click the Additional Criteria button to use any G/L account field to filter accounts for copying. Click 
OK to save. 

Select accounts using ranges of segment codes: 

You can specify ranges for all of the account segment codes.  

For example, the following screen shows that only division 200 accounts will be included. 

 

Substitute segment codes when copying: 

This checkbox lets you copy a group of accounts with one segment code value to create a new group 
of accounts with a different segment value.  

 

Note:  When substituting segments, Extended G/L Accounts allows copying from a company to 
itself.  

While other companies can be selected, the operation will only be performed on those 

companies that have the target segment code.  

For example, if one of your account segments shows the type of store – e.g. retail – you can copy the 
accounts with this segment to create a new set of Webstore accounts in another company DB. 

• Select the Substitute Segment Code checkbox, choose the segment that you want to substitute 
values for, and then specify the source and target values. 

• The new segment values must already be added to General Ledger using the TaiRox Extended 
G/L Segment Codes form or the Sage 300 Segment Codes form.  

The operation will only be performed on those companies that have the target segment code. All 
exceptions will be logged. 

For example, if you want to add accounts for new segment code “400” to a company, you must 
add the “400” segment code before you can copy accounts using segment substitution. 

Load the list of G/L Accounts and choose which ones to copy: 

• Click the Load button to display the list of G/L Accounts that match your selection criteria. 

When you click the Load button, the program will display the G/L accounts in the account and 

segment ranges and with the additional criteria that you specified. 
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o You can adjust the ranges or additional criteria if necessary, and then click Load again. 

 

• Click the Select All and Select None buttons at the bottom of the screen to include all or none of 
the accounts loaded in the grid for copying. 

 

• Double-click in the Include column to “cherry-pick” G/L Accounts: 

 

Click the Copy button to display the To Companies screen:  

When you are happy with the set of accounts that you have selected, click the Copy button at the 

bottom of the screen. 
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Select whether to insert new codes or update existing ones in target companies: 

Before proceeding, you must decide whether to add or update codes in the target companies.   

For example, choose Update Only to update account descriptions for all accounts. 

 

• Choose whether to insert, insert and update, or just update G/L accounts.  

o Insert Only will add codes if the code does not already exist in target companies. It will not 

change existing codes. 

o Update Only will only update codes in target companies that already exist – but not add new 

ones. 
If updating codes only, you can also choose to update the description only. 

o Insert and Update will perform both of these operations. 

Specify which data to update/insert: 

 

• Choose which data you want to update – account descriptions only – or whether you want to 
include account multicurrency information. 

o “Update Account Description Only” appears for Update Only.  

This checkbox will change account descriptions only – it doesn’t matter whether other 

account properties match. 

The “Include Account Multicurrency Information” choice disappears if you choose “Update 

Account Descriptions Only”. 

o If you have multicurrency companies, you should select the option to “Include Account 

Multicurrency Information”. 

Before selecting “Include Multicurrency Information”, you should clearly understand the 

possible consequences and check results first in a test environment. Seeking advice from a 
certified consultant familiar with multicurrency account setup is also recommended.    

o Do not choose “Include Account Multicurrency Information” if the target company is a single 
currency company. 

Copy Accounts will not copy any account information from a multicurrency company to a 
single currency company if you choose “Include Account Multicurrency Information”. 

• Except for the special case of changing the description only, an update operation will attempt to 
change the account in the target company to be just like the account in the source company.  

In order to do so, it will delete various properties (such as Optional Fields) from the target account 

and then add the properties from the source account. It’s possible for the update to fail if 
properties don't match or accounts are in use. 
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“Include Multicurrency Information” options: 

Copy G/L Accounts provides two additional options if you choose to include multicurrency 
information: 

 

• Set Account Default Currency to Target Company’s Function Currency. 

This option lets you copy multicurrency accounts to a G/L that has a different functional currency. 

 

For example, if you copied accounts to a target company with functional currency CAD, the 
default currency for each copied account would be set to CAD – as above. 

If you do not select this option, the program will copy the default currency for the source account 
to the target company. 

• Allow Posting in All Currencies. 

This option selects the “Post in All Currencies” option in the target company for all copied 

accounts. 

If you do not select this option, the program will copy the “Post In” settings from the source 

company – including lists of specified currencies from the source general ledger. (The program 
will add the default currency to the list if it is not there.) 

Note that all multicurrency fields in the target account are ignored if the source account is not 
multicurrency. 

Select target Sage companies: 

 

• Click the Select All and Select None buttons at the bottom of the form to include all or none of the 
target companies. 

 

• Click the checkboxes to complete your company selections. 
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Click the Copy button in the pop-up To Companies screen to copy accounts:  

 

• Click the Copy button to start the copy procedure. 

• Enter your User ID and password in the Sage 300 Sign-On window and click OK. 

Note:  You MUST have sufficient permissions to update G/L accounts in the target companies for 

copying to proceed. 

• The program will copy the G/L account information to the target companies. 

• If no changes are required for a selected account, no update will be performed – so the audit 
stamp will be preserved. 

• If you cancel the operation during the copying process, you must check the log to see which 
procedures were completed and assess how you want to continue. 

Click the Log button to confirm which G/L Accounts were processed: 

7/30/2020 2:48:58 PM Copy G/L Accounts to Companies started. 

7/30/2020 2:48:58 PM  

7/30/2020 2:48:58 PM Logged in user: ADMIN 

7/30/2020 2:48:58 PM Performed by user: MORGAN 

7/30/2020 2:48:58 PM  

7/30/2020 2:48:58 PM Insert Only 

7/30/2020 2:48:58 PM Include Account Multicurrency Information: No 

7/30/2020 2:48:58 PM Copy G/L Accounts to Companies: Sample Company Inc. 

7/30/2020 2:48:58 PM                                 Sample Company Limited 

7/30/2020 2:48:58 PM  

7/30/2020 2:48:58 PM Copying accounts from Productivity Tools Demo to Sample Company Inc. 

started. 

7/30/2020 2:48:58 PM     Logging in to Sample Company Inc.... 

7/30/2020 2:48:58 PM     Inserting account 1024... 

7/30/2020 2:48:58 PM         Account inserted. 

7/30/2020 2:48:58 PM     Logging off of Sample Company Inc.... 

7/30/2020 2:48:58 PM      

7/30/2020 2:48:58 PM     There was 1 account inserted. 

7/30/2020 2:48:58 PM Copying accounts from Productivity Tools Demo to Sample Company Inc. 

complete. 

7/30/2020 2:48:58 PM  

7/30/2020 2:48:58 PM Copying accounts from Productivity Tools Demo to Sample Company Limited 

started. 

7/30/2020 2:48:58 PM     Logging in to Sample Company Limited... 

7/30/2020 2:48:58 PM     Inserting account 1024... 

7/30/2020 2:48:59 PM         Account inserted. 

7/30/2020 2:48:59 PM     Logging off of Sample Company Limited... 

7/30/2020 2:48:59 PM      

7/30/2020 2:48:59 PM     There was 1 account inserted. 

7/30/2020 2:48:59 PM Copying accounts from Productivity Tools Demo to Sample Company Limited 

complete. 

7/30/2020 2:48:59 PM  

7/30/2020 2:48:59 PM  
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7/30/2020 2:48:59 PM Copy G/L Accounts to Companies complete. 

7/30/2020 2:48:59 PM 

================================================================================ 

The Log lists: 

• The user, the type of operation performed, and the range of accounts.  

• Each account that was processed and whether the accounts were updated or inserted.  

Detailed example of Segment Substitution  

Suppose we have a Segment Code “Division”. Further suppose we have some accounts in Division 100 

that we wish to copy to a new Division 300 in multiple companies. 

Important Note: There are many different ways to arrange charts of accounts and segments across 
multiple companies. This section illustrates how Extended G/L Accounts can be used in one scenario. 

Step 1: Create a new division 

The first step is to create the new Division in all the appropriate companies using Sage G/L Segment 

Codes or the TaiRox Extended G/L Segment Codes screens. 

 

Step 2: Specify a range of accounts for copying 

The second step is to specify the range of accounts in the Copy Accounts function, in this case, account 

5400-5410 with its Divisions and Regions. 

 

Step 3: Specify a division with the accounts you want to copy 

Since we are copying division 100 accounts, you need to specify the segment range on the Copy G/L 
Accounts screen: 
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Step 4: Select the Substitute Segment checkbox 

Click on the Substitute Segment Code checkbox to display the fields for the substitution option. Specify 

that we want the accounts to be copied, substituting Division 100 with Division 300 

 

Step 5: Click the Copy button 

Click the Copy button to pop up a window where you can select multiple companies. 

Note: when substituting segments, Extended G/L Accounts allows copying from a company to itself.  

While other companies can be selected, the operation will only be performed on those companies 
that have the target segment code.  

 

Step 5: Click the Copy button on the “To Companies” screen to continue 

Enter the User ID and password for copying accounts to the target companies. 
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Step 6: Display the Log to confirm the accounts that were copied 
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